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Summary
• This document describes KaeMix Student’s features, user 

interface, and how to use the program

• For instructions on how to install KaeMix Student, see the 
installation guide 
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Screen Layout

Design List

Left panel, multiple tabs with process 
and design inputs

Access tabs from Ribbon or Process, 
Design, and Performance menus

Menu Bar

Ribbon

Right panel:
• Drawing 
• Results
• Report
• Guides

List Commands
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Built In Examples

File → Open Examples

This will open a file with multiple 
examples that highlight KaeMix’s 
capabilities
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Design Examples

Default design: 
single hydrofoil

Multiple hydrofoils Hydrofoils and a sweeper

Hydrofoils, a disk 
turbine, and gas sparger

Rectangular vessel with 
sloped bottom Multiple impellers and 

spargers
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Multiple Design Capability

KaeMix allows multiple designs in one file. These are shown 
in the Design List. These can be moved, sorted, duplicated, 
etc. You can also tag them and add comments. Select designs 
by clicking in the list. 
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Unit Systems: Metric and USA

Select your preferred units
Keyboard shortcuts are:
ctrl-m → Metric units
ctrl-u  → USA Customary units
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Workflow
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Workflow

In the right panel you 
can view your progress 
from either the 
Drawing or Results tab

Typically start in the left panel with the 
design information or vessel design, and 
then move through the tabs from left to 
right: vessel, process, liquids, gas, solids, 
drive, impellers, baffles, etc.
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Drawing

Caption with summary of results 

Bottom depth

Top head depth

Straight side

Operating level (includes liquid and 
solids, not gas, specified by user)

Gassed operating level 
(calculated by KaeMix)

Baffles

Shaft

Gas sparger

Impellers
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Results
• Pu: total power draw of all submerged impellers, ungassed

• Pg: total power draw of all submerged impellers, gassed

• Pg/Pu: ratio between gassed and ungassed power draw

• Main Impeller: name of the impeller with the highest power draw

• % Power Draw: main impeller power draw as percentage of total

• Reynolds Re: Reynolds number of main impeller

• Description: if flow is turbulent or laminar

• Power Po: main impeller power number

• Shear Rate: shear rate in region of main impeller

• Eff. Visc.: effective viscosity based on main impeller shear rate

• M-Scale: a 1 to 10 scale of agitation for liquid mixing

• Blend time: time to reach 100% uniformity in liquid

• Cavern volume: volume of caverns around impellers for yield stress fluids

• M-Phase: a 1 to 10 scale of agitation for the gas and/or solids phases

• Particle Suspension: percentage of the solids suspended into the liquid

• Impeller Speed / Njs: ratio between impeller speed and the just-suspended speed 
for the impeller that contributes the most to the off-bottom suspension

• Cloud H/Z: ratio between the height of the solids cloud and the operating level

• Gas Dispersion:  if the gas is being dispersed or the impeller is flooded

• Gas Holdup: volume of gas divided by total volume (liquid + solid + gas)

• Kla: gas-liquid mass transfer coefficient 
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M-Scale
• Originally, a 1 to 10 Scale of Agitation* for blending applications, 

described in: 
“How to design agitators for desired process response” 
Hicks et al., Chemical Engineering, April 1976

• Scale of 1 to 10:
▪ M-Scale 1-2 are for applications requiring minimum fluid velocities to achieve the process result. 

▪ M-Scale 2 will blend miscible liquids to uniformity if specific gravity differences are less than 0.1; 
blend miscible fluids to uniformity if the viscosity of the most viscous is less than 100 times that of 
the other; establish complete fluid-batch control; and produce a flat, but moving, fluid-batch 
surface.

▪ M-Scale 3-6 are characteristic of fluid velocities in most chemical process industries agitated 
batches. 

▪ M-Scale 6 will blend miscible liquids to uniformity if specific gravity differences are less than 0.6; 
blend miscible fluids to uniformity if the viscosity of the most viscous is less than 10000 times that 
of the other; and produce surface rippling at lower viscosities.

▪ M-Scale 7-10 are characteristic of applications requiring high fluid velocity for the process result, 
such as in critical reactors. 

▪ M-Scale 10 will blend miscible liquids to uniformity if specific gravity differences are less than 1.0; 
blend miscible fluids to uniformity if the viscosity of the most viscous is less than 100,000 times 
that of the other; and produce surging surfaces at low viscosities.

M-Scale Descriptions
1: Slow
2: Mild
3: Moderate
4: Intermediate
5: Medium
6: Medium-Strong
7: Strong
8: Very Strong
9: Powerful
10: Very Powerful*

* In KaeMix the scale 
has been extended to a 
maximum of 14
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Report

You can view a report from the right panel. 

To print it, right click in the report to get the 
print menu or use File → Print.

You can save the report or send it to MS-
Office or LibreOffice from the File menu.
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Guides

© 2025 KaeMix LLC



© 2025 KaeMix LLC 15KaeMix Student User Guide

Guides: Applications

The Application guide provides 
advise on the scale of agitation 
required for various applications

Scale of Agitation: a 1 to 10 mixing scale 
indicating agitation intensity: M-Scale

Source: Gates, Hicks, Dickey. Application 
guidelines for turbine agitators. Chemical 
Engineering. Dec. 1976. pp. 165-170

M-Scale: 9 to 10
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Guides: Equipment 

The Equipment guide in the right 
panel let’s you view the different 
impeller and equipment styles that 
are available in KaeMix
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File and Design Info
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File Info

In the File Info tab you can enter relevant 
information about the contents of this file. 

Enter the file 
information here

Enter notes  here
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Design Info

In this tab you can enter design 
related information and notes. 

Note: whereas the File Info applies to the whole file, the 
Design Info is separate for each design in the file.
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Vessel Design
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Vessel Design (1/3)
Vessel Styles 

Sealing Options

Bottom Styles

Materials
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Vessel Design (2/3)

Settings | Equipment Preview OFF
Standard dropdown when clicking 

Bottom Style

Settings | Equipment Preview ON 
opens graphical selection panel 

when clicking Bottom Style

Close the panel 
by clicking x-box 
or press Enter or 
Esc on keyboard
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Vessel Design (3/3)

Bottom Depth

Top Head Depth

Straight Side

Vessel Diameter

Operating level

Impeller Set
First Bottom Clearance

Impeller Set
Last Bottom Clearance

Set of   two 
impellers

Cylindrical
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Process
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Process Operating Conditions
Operating level includes liquid and solids but excludes gas. 
Measured vertically from the deepest point in the bottom. 
Minimum level is the bottom depth. Maximum level is to the 
top of the straight side

Gassed operating level includes gas and is calculated by KaeMix

Operating volume corresponding to operating level. You can 
specify either volume or level and the other is calculated

Operating temperature

Operating pressure (in the head space)

Average pressure in the liquid, and pressure at the deepest 
point at the bottom, in Atmosphere (or Bar depending on 
settings), calculated by KaeMix

If you specify continuous flow and a flow rate, KaeMix will 
calculate the residence time

Specify an additional level for in the drawing
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Liquids (1/3)

If you select a liquid from the dropdown list the physical 
properties will be set automatically. The properties are 
constant, except for Water (T-dependent) in which case 
density and viscosity vary with temperature.

Important: To specify your own liquid with your own 
physical properties, first enter a name that does not 
appear in the dropdown list!
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Liquids (2/3)

Newtonian, Power Law (“pseudo-plastic”), and 
Yield Stress (“Herschel-Bulkley”) viscosity 
models are available

Newtonian Fluid:  = constant (enter in mPa.s = cP)

Power Law Fluid:  = =1/s 
(n-1) = k (n-1) 

Yield Stress Fluid:  = yield/ + k (n-1) 

Fluid is stagnant if  < yield

 Viscosity at shear rate  (1/s)

=1/s Viscosity at shear rate  = 1 (1/s)

k Consistency (enter in mPa.sn = cP.s(n-1))
n Flow Index
yield Yield Stress (enter in Pa or Dyne/cm2)
 Shear Stress (Pa)

You can select 
safety 
information 
from the 
dropdown list or 
enter your own 
text
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Liquids (3/3)

If cavern volume is less than 100% of the 
operating volume, M-Scale will be 0/10 
and no other performance information 
will be calculated. Only when agitation is 
increased so that cavern volume = 100% 
will other information be calculated

Yield stress fluid specified

If there is insufficient agitation with a yield stress fluid, a cavern may 
form around the impeller in which fluid moves, while fluid outside the 
cavern remains stagnant. KaeMix calculates the approximate cavern size

Approximate outline of cavern is shown if 
Settings → Drawing with Colors is OFF

Cavern light-blue and stagnant liquid pale-yellow 
if  Settings → Drawing with Colors is ON



© 2025 KaeMix LLC 29KaeMix Student User Guide

Design Tools
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Quick Agitator Design
•After specifying the vessel, process, 

and liquids, the fastest way to 
create an initial agitator design is 
using the Quick Agitator Design 
panel

• Specify the impeller system and 
required M-Scale, click Design, and 
KaeMix will design the agitator
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Tools Menu
• Reposition Impellers: spaces impellers over vessel height

• Scale-Up: opens the Scale-Up panel

• Load Motor: adjust speed and diameter to load motor

• Impeller Speed: adjusts speed only to load the motor

• Impeller Speed (Standard): sets the highest standard RPM 
that does not overload the motor

• Resize Impellers: adjusts diameters to load motor

• Resize Motors: changes motor size to match impeller 
power draw

• Drives – Top Entering: changes bottom entering drive to 
top entering

• Drives – Bottom Entering: changes top entering drive to 
bottom entering

“All Designs” means that this change is 
applied to all designs in the file, not 
just to the active design. It is 
recommended to save your file before 
issuing these commands
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Create Menu
• Create menu: useful to quickly create an 

impeller system before manually refining the 
design

• These commands duplicate the active design 
and replace the impeller and baffle system 
with the system selected from the list
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Scale-Up
• Tools → Scale-Up 

• You can scale up or down

• You can change the aspect ratio of the 
vessel by modifying the ratio between 
Straight Side and Vessel Diameter

• Available Scale Up criteria:
▪ Equal Blend Time
▪ Equal Froude Number
▪ Equal Mixing Scale (M-Scale)
▪ Equal Power per Volume
▪ Equal Reynolds Number
▪ Equal Shear Rates
▪ Equal Tip Speed
▪ Equal Torque per Volume

• Clicking Scale-Up adds a new design
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Drives and Shafts
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Drives

A drive consists of a motor-gearbox and a shaft

Enter shaft rotational speed here

Enter motor power here
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Drives – Shaft Design

Shaft Length is calculated as follows:
Length = Top Head Depth 
 + Vessel Straight Side 
 + Bottom Depth 
 - Shaft Off Bottom

Shaft Design can be set to Automatic or 
the shaft can be specified by the user.

Shafts can be solid or hollow.
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Impellers
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Available Impellers
 

 

 

 

 

 

 
Hydrofoil Narrow Hydrofoil Medium Hydrofoil Wide HF Extra Wide 

 
 

  
Propeller Pitched Blade  Straight Blade Rushton Turbine 

    

Van‘t Riet Turbine Smith Turbine Middleton Turbine Bakker Turbine 

   

 

Sweeper Straight Sweeper Curved Sweeper Angled  

 

High-Efficiency
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Select Impeller Type

Settings | Impeller Preview OFF
Standard dropdown when clicking 

Impeller Type

Settings | Impeller Preview ON 
opens graphical selection panel 

when clicking Impeller Type Close the panel by clicking 
x-box or press Enter or 
Esc on keyboard
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Impeller Dimensions

Impeller Diameter D to enter in KaeMix

This is the Swept Diameter Dswept. 
Do not enter this in KaeMix

Blade Width W = Blade Height H

Blade Angle

Blade Height H

Blade Width W

Blade Thickness 
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Multiple Impellers of Different Type

A single drive and shaft with multiple different impellers.
Impeller Set 1 is a disk turbine. Impeller Set 2 consists of two wide-blade hydrofoils.

Set 2

Set 1

You can have up to eight 
different impeller sets.

Enable or disable sets using 
the check boxes.

To specify an impeller, select 
Style first, then Type.

You can swap /order impeller 
sets with the           buttons.
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Multiple Impellers of Same Type

Single Drive

Four impellers are specified as well as the off-bottom clearance of the first 
and last impeller. The impellers are then equally spaced along the shaft.

Bottom clearance is defined as the vertical distance from the bottom of the 
impeller to the lowest part in the vessel bottom.

One set of four impellers connected to Main Drive
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Baffles
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Baffle Design

A sweeper is an impeller 
that matches the shape 
of the bottom and is 
close to it. Blades can be 
vertical / straight, 
pitched, or curved. 

In the Baffles tab you can choose Automatic design or Manual design. 
Here Automatic is selected, and this follows these rules in this order:
- Rectangular → no baffles
- All impellers Re < 100 → no baffles
- All impellers Re < 300 → two flat baffles (T/12 at T/72)
- All other configurations → four flat baffles (T/12 at T/72)
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Baffle Design – Manual 

Baffle to Wall

Baffle Width

Baffle type 
“Standard – Flat” 
allows you to 
prescribe the 
location and size of 
the baffles in detail

Baffle to Bottom Straight Side

Baffle to Top Straight Side
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Gas Dispersion
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Gas Dispersion – Flow Regimes

✮✮✮✰ 
Complete Dispersion (3/4)
Gas is dispersed and there is 

gas recirculation

✮✮✮✮
Fine Dispersion (4/4)

Gas dispersed and substantial 
recirculation. Small bubble 

size aids mass transfer 

✮✮✰✰
Dispersing (2/4)

Gas is dispersed towards the 
vessel wall, but there is little 

or no recirculation

✮✰✰✰
Coarse Dispersion (1/4)

Impellers not flooded. Some 
gas reaches vessel walls, 

especially near upper impellers

✰✰✰✰ 
Flooded (0/4)

Gas rises straight through 
the impellers

Suitable for critical gas-liquid reactors where 
rapid mass transfer is required

Reactors requiring moderate 
degree of mass transfer

Applications that are not mass 
transfer limited

Avoid this flow regime

Increasing impeller speed N

Rated from zero stars ✰✰✰✰ 
to four stars ✮✮✮✮
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Gas Dispersion

Open the Gas Flow tab to enter the gas 
dispersion related information. Here you 
can also access the Sparger Design and Gas 
Dispersion Results tab.

Enable gas 
dispersion here

Sparger Design

Gas Dispersion Results
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Gas Dispersion – Process Gas

If process gas is selected from dropdown list 
the physical properties are set automatically.

Important: To specify your own properties, 
first type in a name for the process gas that 
does not appear in the dropdown list!

Specify process gas
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Gas Dispersion – Flow Rate (1/2)

To enter the gas flow rate, first select 
the Gas Flow Unit, then enter the Gas 
Flow in that unit

For viscosity model select Liquid, Fermentation Broth, 
or Fine Suspension as appropriate. 

None is for situations where you specified the value of the 
diffusion coefficient that you want to be used without 
additional corrections. 

Note: if both the process liquid and the process gas are selected 
from the dropdown lists then the viscosity model setting is 
disabled and KaeMix automatically selects the best model

Specify gas flow

Specify bubble coalescence behavior. 
If unsure, select coalescing.
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Gas Dispersion - Flow Rate (2/2)

VVM is gas volumetric flow rate / 
operating volume per minute

VVM and superficial gas velocities 
are calculated based on average gas 
temperature and average pressure

Standard Conditions mean the 
International Standard Metric 
Conditions: 15⁰C / 59⁰F at 1 Atm

Actual Conditions are defined as the 
temperature and the pressure at 
the bottom

Gas flow rates in USA units are 
shown if KaeMix is set to USA units

Tip: it is best to enter gas flow as 
a mass flow rate because not 
everyone uses the same 
definitions for standard or actual 
conditions used in volumetric 
flow rate calculations

Here, CFM is Cubic Feet per Minute.
Standard is 59⁰F at 1 Atm
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Gas Dispersion - Results
Main impeller: the lowest impeller that is directly gassed

Flow Regime: Flooded means the gas rises through the impeller 
system without being driven to the wall. Coarse Dispersion means 
gas is driven direction vessel wall but may not completely reach it 
and there is no recirculation. Dispersing means that gas is driven to 
the vessel wall and some smaller bubbles may recirculate. Complete 
dispersion means that gas is also driven down at the vessel wall and 
part of the gas recirculates through the impeller system

Gas holdup and mass transfer coefficient kla are shown for the 
process / actual conditions; for water / standard conditions (15⁰C/ 
59⁰F and atmospheric pressure); and for the custom correlations

The following is not included in holdup and kla calculations:
○ Power input by impellers below the lowest sparger
○ Gas input from spargers above the highest impeller
○ Impellers and spargers located above the user specified operating 
level (which is ungassed)

Dip tube spargers work less well than other spargers and a reduced 
efficiency is assigned to them
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Sparger Design

Here a set of four spargers is specified

Spargers
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Solids Suspension
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Solids Suspension – Flow Regimes

✮✮✮✰ 
Complete Suspension (3/4)
All solids are in motion. When 

deposited on the bottom, solids 
stay there only briefly 

✮✮✮✮
Fine Suspension (4/4)
All solids are distributed 
throughout the vessel 

✮✮✰✰
Solids Motion (2/4)

All solids are in motion. 
Some solids are moving 
around on the bottom

✮✰✰✰
Partial Motion (1/4)

Most particles are in motion. 
There are still some stagnant 

solids on the bottom

✰✰✰✰ 
Settled Solids (0/4)

All or most solid particles are 
settled on the bottom

KaeMix reports percentage of solids that are unsuspended
KaeMix reports cloud height CH/Z. Cloud height depends on 

impeller placement, especially in tall vessels

The point at which this transition occurs is called just-
suspended and the impeller speed is denoted as Njs

N < 0.7 Njs N < 0.8 Njs N < Njs
N ≥ Njs

N > Njs

CH Z

KaeMix warning: Operating at 
N < 0.8Njs is not recommended

Increasing impeller speed N

Rated from zero stars ✰✰✰✰ 
to four stars ✮✮✮✮
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Solids Suspension

Enable solids 
suspension here

Open the Solids tab to enter 
the solids suspension related 
information. Here you can also 
access the Suspension Results 
tab.

Tip: particle diameter can be: 
• entered directly,
• or calculated from mesh, e.g., 

enter size as “100 mesh” or 
“1/4 mesh”
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Solids Suspension Results (1/3)
• Njs is the just-suspended speed

• Main impeller is name of impeller that contributes most 
to the off-bottom suspension process

• Three methods are used to calculate this:

1. Njs GMB: Grenville-Mak-Brown (2015). Down pumping axial flow 
impellers. Scaleup exponent is -0.67

2. Njs CFM: Corpstein-Fasano-Myers (1994). Both down and up 
pumping axial flow impellers. Scaleup exponent depends on 
particle properties. 

3. Njs Zwietering: Zwietering (1958). Radial and axial flow 
impellers. Scaleup exponent is -0.85. 

• Njs is reported as the average of these calculations

• The percentage of unsuspended (settled on the bottom) 
solids, the percentage of suspended solids, and the 
Cloud Height / Z (operating level) ratio are reported also 
for conditions where these can be calculated

Solids Suspension Results



© 2025 KaeMix LLC 58KaeMix Student User Guide

Solids Suspension Results (2/3)

• The Cloud Height / Z (operating level) 
ratio is reported also for conditions where 
this can be calculated

• A cloud height CH/Z of 100% means that 
the solids cloud reaches the liquid surface
• Note that this does not mean that the solids 

are 100% uniformly distributed throughout 
the liquid: there may still be concentration 
gradients

• Cloud height calculations are based on 
Hicks M.T., Myers K.J., Bakker A. (1997) 
Cloud Height in Solids Suspension 
Agitation, Chem. Eng. Comm., Vol. 160, 
pp 137-155.

Operating Level Z

Solids Cloud 
Height CH

In this experiment, cloud height CH / Z ≈ 60%
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Solids Suspension Results (3/3)

Line for cloud height

(dash – double dot)

Line for settled solids bed

(dash – single dot)

• If Settings | Draw Solids Levels is On 
then KaeMix will draw lines at the 
predicted cloud height and at the 
height of the solids bed if all solids 
were settled

• Limitations: only for cylindrical and 
rectangular vessels for which solids 
suspension calculations can be 
performed. Cloud height only drawn 
if able to be calculated. If CH/Z = 
100% then operating level and 
cloud height are the same and line 
for cloud height may not be visible
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Results
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Blend Time

Blend times required to reach a certain 
degree of uniformity are presented. Both 
ungassed and gassed blend times are shown.
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Drive Loads

Power draw and motor 
load are shown

The design list shows for each design, for the 
main drive: the speed, the power draw, the motor 
capacity, and the motor load
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Power Draw Details

Ungassed torque M, flow / pumping rate 
Q, and power P per impeller

Ungassed totals for the impeller set

Gassed totals for the impeller set

Gassed values per impeller
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Dimensionless Numbers

Dimensionless numbers are 
shown for each impeller set

Reynolds Re =  N D2 / 
Froude Fr = N2 D / g
Power Number Po = P / ( N3 D5 )
Pumping Number Nq = Qimpeller / (N D3)
Gas Flow Number Fl = Qgas / (N D3)
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Managing Designs
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Managing Designs – Design List

To add another design, click New or Duplicate. New will 
add a default design. Duplicate creates a copy of the active 
design. You can also delete designs you no longer need

Use Copy and Paste to Tab if you want to copy inputs from one design 
to another. In the first design, click on Copy Inputs from Tab and the 
inputs from the active tab will be stored. Go to the second design, and 
click Paste Inputs to Tab and the inputs will be pasted in this design

You can add a Tag (e.g., a name, 
label, or keyword) and a 
Comment to each design

The and ✘ 
indicate if a 
design passed 
or failed basic 
design checks 

You can edit the speed 
for the Main Drive here
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Managing Designs - Sorting

You can reorder the 
design list by moving 
designs up, down, to 
the top, or the bottom

To sort the whole list, click on 
the Sort A→Z  or Z→A buttons 
in the list commands. This will 
bring up the list of variables 
that you can use to sort
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Managing Designs - Undo and Redo

If you are going to make a lot of changes, it’s a good idea to first 
Duplicate Design so that you still have a copy from before the changes

Undo and Redo can be accessed 
from the ribbon and the Edit menu.
There is one Undo level
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Menus
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File Menu
Only one file can be open at a time. So, if you Open a file, it will 
close the current file and then open the new file

If you Insert a file, the current file will stay open, and all the designs 
from the file you select will be copied into the current file

Save and Save As save all the designs in the file

Save Active Design Only saves a new file with only the active design 
(the design selected in the Design List). Then if you open another 
existing file and insert the file you just saved you have in effect 
copied that design into your existing file

Open Last Session opens the file that was automatically saved when 
you exited KaeMix previously

Open Examples opens a file with several helpful examples

Close and Start New closes the open file and starts a new file 

Save Report saves the HTML report for the active design. Tip: the 
HTML report can also be read into Excel, Word, Calc, and Writer
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Help Menu

About KaeMix

License Agreement: Important!

Documentation
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Window Menu

Refresh recalculates 
everything and 
redraws the screen

Standard Layout restores 
the KaeMix window 
layout to its default
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Send

© 2025 KaeMix LLC
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Send to Office Applications

KaeMix Report in Excel

KaeMix Report in Word

KaeMix checks if these applications are installed, and if 
so, enables Send To functionality:
• Microsoft Office ("C:\Program Files\Microsoft Office")

• LibreOffice ("C:\Program Files\LibreOffice\program")

• Paint.Net ("C:\Program Files\paint.net"). If Paint.Net is 
not found it will enable Microsoft Paint instead
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Send Drawing to Paint or Paint.Net

KaeMix drawing in Paint.Net

You can also click the 
Copy Drawing button 
or Edit → Drawing to 
Clipboard. This will 
copy the drawing to 
the Windows 
clipboard. You can 
then paste it into 
other programs (e.g., 
PowerPoint)

To edit or print the 
drawing send it to 
Paint.Net (or Paint)
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Settings

© 2025 KaeMix LLC
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Settings
• You can easily switch between Metric 

and USA units using the Units button in 
the ribbon or the Settings menu

• If you want your last session 
automatically restored when you launch 
KaeMix then select the Open Last 
Session on Launch setting
▪Note, you can also do this manually from File 

→ Open Last Session

• The text in the menu bar is by default in 
upper case font. If you prefer proper 
case, you can select this in the Settings 
menu
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Settings – Optional Units
• Settings → Optional Units
▪ Speed in RPM (instead of rev/s)

▪Pressure in Bar (instead of Atm)

▪Particle diameter in mm 

▪Particle diameter in micron

▪ Flow rate in m3/hr (instead of m3/s)

▪ Flow rate in m3/min (instead of m3/s)
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Settings - Previews
• Equipment and impeller 

selections can be made 
graphically using Previews or 
using standard text dropdowns

• This feature is enabled from the 
Settings menu. There is one 
setting for Equipment (bottoms, 
heads, baffles, spargers) and one 
for impellers

• Previews can also be enabled or 
disabled from the corresponding 
icon in the ribbon
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Settings – File Location
• You can control where KaeMix files are saved by default

• Default is [User]\KaeMix folder and usually looks  like this: 
“C:\Users\yourname\KaeMix”

• To change the default, select “Start in” Folder instead

• Specify the “Start in” Folder as follows
▪ Right click on the KaeMix icon on the desktop and then click on 

Properties

▪ Then specify the “Start In” folder and click Apply. Next time you 
launch KaeMix it will default to the “Start In” folder that you 
specified here
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Settings: Decimal Separator

• By default, KaeMix uses the decimal 
point as the decimal separator, e.g. 
“3.14”

• This can be changed to the decimal 
comma, e.g. “3,14” from the Settings 
menu
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END
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